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New in Acrobat IX
Form Edit Mode


Form Edit mode
Choose Forms | Add or Edit Fields 
and you enter Form Edit mode. 
All the form tools are found in this 
mode only. 


The Fields panel is also located in 
this mode and not available in  
normal Viewer mode.


To exit Form Edit mode and return 
to Viewer mode, click the Close 
Form Editing button in the top 
right corner of the Form Edit mode 
interface. To test fields, you can stay 
in Form Edit mode and click the 
Preview button where you can add 
data to field objects to test them.


To edit fields on a page in Viewer 
mode, open the Advanced Editing 
toolbar and click the Select Object 
tool. Double click a field to open 
the field Properties window. A  
Button tool also appears on the  
Advanced Editing toolbar where 
you can add Button fields also in 
normal Viewer mode.
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Menu Commands Available by Mode
Menu commands vary according to the mode you choose to work on a form.  
Use this table as a reference for knowing what menu commands are available according to mode.


Commands According to Mode


Menu Commands Viewer Mode Form Edit Mode


Start Forms Wizard  


Add or Edit Fields  


Close Form Editing  


Distribute Form  


Compile Returned Forms  


Form Tools * 


Edit Fields  


Show Field Properties ** 


Manage Form Data (Submenu commands)  


Track Forms  


Highlight Fields  


Clear Form  


QuickBooks (Submenu commands)  


Advanced Menu (Enable Features in Adobe Reader)  


Advanced Menu (JavaScript commands)  


Advanced Menu (Page Templates)  


 *  The Button tool is available on the Advanced Editing toolbar in Viewer mode.
 ** You can open the Properties window via a context menu or by double clicking a field with the Select Object tool
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2 Filling in Fields in Form Edit Mode
You edit forms in Form Edit mode in Acrobat 9. When add-
ing fields you may need to check calculation formulas, fill in 
data to form barcodes, or preview a form in other ways.


While in Form Edit mode, do the following:


 Click Preview in the Form Edit mode Toolbar


While in the Preview mode you can fill in forms and check 
your scripts. To exit the Preview mode click the Edit Layout 
button.


Using Run Form Field Recognition
In Acrobat 8 you had the Forms | Run Form Field Recognition 
command. Acrobat 9 has the same detect fields options as you 
had in Acrobat 8, but there is no commend for RFFR. Acrobat 
automatically detects fields on a form when you choose Forms | 
Add or Edit Fields. Choosing this command opens your form in 
Form Edit mode.


Open a form in Acrobat 9 and choose Forms | Add or Edit 
Fields. The Add or Edit Fields dialog box opens.


Click Yes and Acrobat automatically detects fields on your form. 
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If one field exists on a form and you open 
the form in Form Edit mode, no fields are 
detected. Select any existing fields on a form 
and choose Edit | Cut. Reopen the form in 
Form Edit mode and you are prompted to 
have Acrobat detect fields. Click Yes and you 
can paste the fields cut prior to reopening in 
Form Edit mode


To exit Form Edit mode and return to normal 
Viewer mode, click the Close Form Editing 
button.
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Adding a Field to a Form
Open the Add New Field pull-down menu in Form Edit 
mode and choose a form tool. The cursor is loaded with the 
selected tool. Do one of the following: 


	Click the mouse button to drop the field on your form.


OR


	Click and drag to shape the field rectangle.


	To name a new field, type a name in the mini Properties  
window. To show all field Properties, click Show All  
Properties.


Adding a Field in Viewer Mode
To add new fields in Viewer mode you must have created at 
least one field for every field type you want to add to a form 
in normal Viewer mode. After creating a field(s) in Form Edit 
mode, do the following: 


	Click the Select Object tool in the  
Advanced Editing toolbar.


	Press CTRL/Option and click + drag a field.  
The field is duplicated on the form.


4
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Using Form Tools
If you opened the Tools menu in normal Viewer mode  
searching for the Forms toolbar, stop now.


There is no Forms toolbar in Acrobat 9. All form tools are only 
available in Form Edit mode EXCEPT the Button tool that ap-
pears in the Advanced Editing toolbar.


Open Form Edit mode and open the Add New Field pull-down 
menu on the Edit Form mode toolbar. If you choose Show Tools 
on Toolbar the tools appear in a row on the toolbar.


To access the Text Field tool 
press the F key. This is the only 
Form tool you can access with a 
keyboard shortcut.


When you press the F key in nor-
mal Viewer mode the Button tool 
is selected.
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Zooming Views in Form Edit Mode
You have several options for zooming the magnification of your 
form in Form Edit mode (the same commands and tools are 
also available in Viewer mode). To zoom in and out:


	Click the Zoom In and Zoom Out tools in the Form Edit 
Toolbar.


	Type a zoom value in the Zoom Percentage text box.


	Open the pull-down menu and choose a preset zoom  
magnification.


	Press CTRL/Command + 0 (zero) to Fit in Window.


	Press CTRL/Command + 1 for Actual Size.


	Press CTRL/Command + 2 for Fit Width.


	Press CTRL/Command + 3 for Fit Visible.


	Press CTRL/Command - (minus) to zoom out.


	Press CTRL/Command + to zoom in.


Comments in Form Edit Mode
If you're looking for the Comment & Markup toolbar in Form 
Edit mode, stop now:


You won't find the Comment & Markup 
tools or any other toolbar available while in Form Edit mode.


If you want a comment to appear in Form Edit mode you 
can add a comment in Viewer mode, copy the comment 
or markup and paste in Form Edit mode. Once pasted, 
you have access to the comment Properties and reshaping 
markups.
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There is no Zoom tool in the Form 
Edit mode Toolbar. For quick ac-
cess to the Zoom tool, press CTRL/
Command + Spacebar to zoom in 
and CTRL/Command+Alt/Option 
+ Spacebar to zoom out. While the 
keys are pressed down, click and drag 
a marquee in the area you want to 
zoom in.


Double clicking a comment in Form 
Edit mode opens the comment's 
Properties window. If you want to 
open a note pop-up window, open 
the window in Viewer mode, then 
copy the comment. When you paste 
in Form Edit mode, the note window 
opens and you can type text in the 
window.


ted’s tip ted’s tip


STOP







ted padova ted@west.net 



using form edit mode


Using Panels in Form Edit Mode
If you're looking for Navigation panels in Form Edit mode, stop 
now.


The only Navigation panel you'll find in Form Edit mode is the 
Fields panel. 


If you're looking for the Fields panel in Viewer mode,  
stop now.


The Fields panel is only available in Form Edit mode.


Renaming Fields
Acrobat 9 provides several ways for you to rename fields. 
When you want to rename a field or multiple fields, do one 
of the following:


	Click a field with the 
Select Object tool in 
either Viewer mode or 
Form Edit mode and 
open a context menu. 
From the menu options 
choose Rename Field. 
The mini Properties 
window opens where 
you can edit the field name.


	Double click a field with the Select Object tool in either 
mode and the General tab opens in the Properties win-
dow. Type a new name in the Name text box.


	In Form Edit mode, open the Fields panel. Double click 
a field to edit a field name.


To change hierarchical 
names do the following:


	In the fields panel 
open the Sort menu 
and choose  
Alphabetic.


	Double click the 
parent name above 
the children for 
a given group of 
names.


	Type a new name for the  
parent name.
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Fields can be sorted in two sort 
orders. From the Sort pull-down 
menu choose Alphabetic Order 
to sort fields alphabetically. 
Choose Tab Order to display 
the fields in the panel in Tab 
Order
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to Acrobat only. None of the 
tasks can be completed in 
Adobe Reader.
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Flattening Fields
Field objects like destinations and links add overhead 
to your files and increase file size. If you have a form 
that no longer requires editing the field data and you 
want to display the form while retaining the data you 
can flatten the fields.


Follow these steps to retain data while eliminating field objects:


	Choose Advanced | PDF Optimizer.


	Click Discard Objects in the left pane in the PDF Optimizer.


	Check Flatten form fields in the right pane.


	Click OK.


	Name the file.


	Click Save. 


12
Editing Images on a Form
If you have a legacy form and don’t have the original applica-
tion authoring document you can edit images in a program like 
Photoshop or Photoshop Elements.


To edit an image do the following:


	Click an image with the TouchUp Object tool.


	Press the Option/Alt key and double click the image.


	By default, the image opens in Adobe Photoshop. 


	Edit the image and click Save (not Save As).


	Your edits are dynamically changed in the PDF document.


Adding Document Properties
Some authoring applications offer you options for adding  
Document Property information such as Title, Subject, Author, 
and Keywords.


If you redesign a form and create several PDFs during the pro-
cess, you’re best off adding Document Property information in 
the authoring application so you don’t have to keep editing the 
properties on each new file in Acrobat.


	In a program like Adobe InDesign, choose File | File Info.


	Fill in the fields for Document Title, Author, Description, 
and Keywords.


	Export to PDF


 The Document Properties are retained. This information 
is particularly important when you want to search for 
forms on your hard drive or server.
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Be certain to provide a new name 
when prompted by the PDF 
Optimizer before you save the file. 
Keep the original file just in case 
you need to go back and make 
some edits in the fields.
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Replacing Pages
The command I use most when creating forms and 
slide presentations is the Document | Replace Pages 
command. I always find myself tweaking the page 
design after I’ve added fields on a form. 


Because Acrobat doesn’t provide you a very good 
editing environment in terms of editing text and  
images, the ideal method for changing documents is to return 
to the authoring program, make your changes and export to 
PDF. 


  


If you added a number of fields to an original design, then 
you’ll want to change the background data while retaining the 
field objects. To to do so:


	Modify a form in the original authoring program.


	Export to PDF.


	Open the file containing field objects.


	Choose Document | Replace Pages.


	Select the new design and click OK.


Replacing Pages in Tiled Views
If you have a number of pages to replace in a document or you 
want a more visual approach to replacing pages, you can drag 
and drop pages between documents. 


Here’s how to do it:


 Open two documents in Acrobat 9.0. One file is your original 
design and the other file is the new design.


	Choose Window | Tile | Vertically.


	Open the Pages panel on both documents.


	Press CTRL/Alt (Win*) or Command + Option (Mac*) and click 
+ drag the thumbnail of the new design to the top of the 
page thumbnail in the old design. The field objects remain 
intact.


	Move the cursor to the page number below the thumbnail 
and wait until the page appears reversed in color (black).


	Release the mouse button and the page is replaced.


15
* Modifier keys are new in Acrobat 9.0.
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I find that when I edit a design 
and export to PDF I name the 
new file with a number preceding 
the file name —something like 
0.myFormDesign.pdf. When it 
comes time to replace the page, 
there’s no question about what 
file I need to use for the page 
replacement.
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Scanning Paper Forms
Many improvements have been added to Acrobat 9 
for scanning paper forms.


To convert a paper form to a fillable PDF form, do the 
following:


	Choose Forms | Start Form Wizard.


	Click the A paper form radio button.


	If using a WIA compliant scanner driver (Windows only) 
click a preset from the Acrobat Scan dialog box. To use 
custom settings, click Custom.


	In the Custom Scan dialog box click Make Searchable 
(Run OCR).


	Click the Options button and choose Searchable Image 
for the PDF Output Style and click OK.


	Click Scan and the file is scanned, OCR is run, and the 
form opens in Form Edit mode where Acrobat detects 
fields on the form.


 Note: for WIA compliant drivers, you can choose Docu-
ment | Scan to PDF | and choose a preset. Presets can be 
edited for scanning attributes. Each time you scan and 
choose a preset, the same attributes you last established 
as defaults are used.


Automating Detecting Fields
You can scan a number of forms and save the forms as image 
files, then later use a Batch Sequence to recognize text and use 
Run Form Field Recognition. 


Here’s how to do it:


 Choose Advanced | Document Processing | Batch Processing. 


	Click New Sequence and type a name for the sequence.


	Click Select Commands in the Edit Batch Sequence dialog.


	Click Optimize Scanned PDF and click Add. 


	Double click Optimize Scanned PDF in the right window.


	Adjust any settings you want for optimizing the scans.


	Click Recognize Text Using OCR in the left window and click 
Add.


	Click Detect Fields in the left window and click Add.


	Click OK through the dialogs and you return to the Batch 
Sequences dialog box. When you run the sequence scans are 
optimized, OCR is run, and Acrobat detects fields.


17
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Exporting PDF Content 
A number improvements have been added to Acrobat 
9 for exporting content back to authoring application 
documents. When you need to edit a form and don't 
have the original application document available, try 
exporting from a PDF to a file format that you can use 
to edit in an original authoring application.


To export a PDF form to Microsoft Word format where 
you can edit the form design, do the following:


	Open a form in Acrobat.


	Choose File | Export | Word Document.


	Click the Settings button.


	The Save as Doc 
Settings dialog 
box opens.


	Choose the set-
tings options you 
want for your ex-
port. If you want to 
retain the layout, 
click Retain Page 
Layout. When your 
file opens in MS 
Word, the layout is 
preserved and the 
text is all editable.


	Click OK and click 
Save and your file 
can be opened in 
MS Word.


Exporting PDF Pages 
If you have a form among several pages in a PDF file and you 
want to export certain pages from the file, you can use the Doc-
ument | Extract Pages command. When the extracted pages 
open in Acrobat you can save the page(es) as a new file.


Another way to handle extracting pages is to use a drag and 
drop method. To extract pages via drag and drop, do the  
following:


	Open a multi-page document in Acrobat.


	Click the Pages panel icon to open the Pages panel.


	Minimize the Acrobat window so you can see part of the 
Desktop in the background or an open folder.


	Select a page(es) in the Pages panel and drag to the 
Desktop (or a folder). The pages are extracted as a new 
file.


19
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Add a New Layer to a Form 
In Acrobat 9 Professional you can add new Adobe PDF Layers 
to a PDF file. Adding layers to PDFs where no layers exist or 
new layers to a layered file is handled in one of two ways. Use 
the Preflight tool from the Print Production toolbar or use the 
Layers panel. 


To add a new layer to a file using the Layers panel,  
do the following:


	Open a form in Acrobat.


	Open the Layers panel in the Navigation pane.


	Open the Options pull-down menu 
(represented by an icon in the 
top left of the Layers panel) and 
choose Import as Layer.


	The Import as Layer dialog box 
opens (shown opposite page).


	In the Import as Layer dialog box 
choose a file to import by clicking 
the Browse button. Type a name 
for the new layer in the text box 
adjacent to the text: Crate new 
layer.


	If you want to move the content on 
the layer around your form, click 
the thumbnail preview and drag to 
position where you like. 


	Click OK and the new layer is 
added to your file.
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When layers are added to a PDF document you 
can show and hide layers with button actions 
and JavaScripts.


You might use a new layer to add a license 
agreement to a form, a Flash video, a layer 
where instructions for filling in a form are pro-
vided or many other uses.


Check out my article in Layers Magazine  
(http://www.layersmagazine.com/) for more 
information on creating new layers in Acrobat 9.
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working with
pdf portfolios


PDF Portfolios can be created 
only in Acrobat. All the pages 
in this part relate to Acrobat 
only.
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Adding Forms to a PDF Portfolio
In Acrobat 8 we had PDF Packages. In Acrobat 9 Adobe 
has introduced PDF Portfolios. PDF Portfolios can be 
helpful when you need pages of instructions along with 
forms. Rather than add instruction pages to a form, you 
can keep the form simple and add other documents to a 
PDF Portfolio.


To create a PDF Portfolio, do the following:


	Choose File | Create PDF Portfolio.


	Click and drag the files you want to add to a PDF Portfo-
lio to the PDF Portfolio interface Document pane or click 
the Add Files button and select files to add.


	PDF Portfolios are organized in an alpha order according 
to file name. To change the order you can add a custom 
sort field in the Details panel. Click Specify File Details in 
the right panel.


	Type a new sort item in the Add a column text box.


	Choose Number from the pull-down menu.


	Double click cells in the new column and type respective  
numbers for the sort order.


Enabling Forms a PDF Portfolio
When you open a PDF Portfolio you're in a Home view where 
you can scroll the documents while viewing thumbnail images 
of the files. In this view you have limited access to menu com-
mands.


To access menu commands such as enabling a file for Adobe 
Reader Usage Rights (now also available in Acrobat Standard), 
double click a file in the Home view. The file remains in the PDF 
Portfolio interface but now you have access to almost all the 
menu commands.


To enable a file for Adobe Reader usage rights in a preview 
view in a PDF Portfolio, do the following:


	Choose Advanced | Extend Features in Adobe Reader.


	Click OK in the Enable Usage Rights in Adobe Reader dia-
log box.


When extending rights in Acrobat, you are prompted to save 
the file. When extending rights on a file from within a PDF Port-
folio, a Save As dialog box doesn't open. Your file is enabled 
and you perform a save when you save the Portfolio (File | Save 
Portfolio). 


22
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Editing Forms in a PDF Portfolio
When you view files in a PDF Portfolio the default view 
is the Home view. If you click a thumbnail image of a file 
in a Portfolio and click the Preview the selected file tool 
in the PDF Portfolio toolbar or double click a thumbnail 
and the file opens in Preview mode.


Preview mode still doesn't provide you the ability to open the 
form in Form Edit mode or access several Forms menu com-
mands. To gain access to full editing options on a PDF form, 
you need to open the file in a new window.


Click the Open button on the far right of the PDF Portfolio 
toolbar and the form opens in a new window.


Once in a new window you can choose Forms | Add or Edit 
Fields to enter Form Edit mode.


24 Adding Navigation Links to PDF Portfolios
If you have a form in a portfolio combined with a few files 
used for instructions and want your recipients to navigate 
the files in a linear view like when viewing a single PDF docu-
ment without using the PDF Portfolio interface, you can do 
so by adding buttons or links for document navigation.


To add navigation links to files in a PDF Portfolio, do the fol-
lowing:


	Open a file in a PDF Portfolio in Preview mode (See 
opposite page).


	Choose Tools | Advanced Editing | Link Tool (or press 
CTRL/Command + L). Note that you don't have access 
to any other Advanced Editing tool except the Link tool 
—even the Button tool is grayed out.


	Create a link on the last page in a document. When you 
release the mouse button the Create Link dialog box 
opens.


	Set the visibility options and click the Custom link radio 
button. Click Next to open the Link Properties window.


	Click the Actions tab and choose Go 
to a page view and click Add. The 
Create Go to View dialog box opens.


	Click the Preview the next file button 
in the PDF Portfolio toolbar to open 
the next file.


	When you locate your target file, click Set Link in the  
Create Go to Link dialog box and the link is created.


 When a form filler wants to navigate your PDF Portfolio 
the user doesn't need to return to the Home view.
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Closing windows can be a little confus-
ing when working with PDF Portfolios. 
When you open a new window by 
clicking the Open button, you close the 
new window like you do any Acrobat file 
(click the Close button or press CTRL/
Command + W). Any edits you made 
are still intact when closing the window. 
When you click the Close button or 
press CTRL/Command + W in the other 
PDF Portfolio views, you close the port-
folio. If you haven't saved an edit, you 
are now prompted to save your file.
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Working 
with Fields


You cannot add or format fields in Adobe 
Reader however, the results of the field edits 
described in this section can be used on  
forms by Adobe Reader users.


Note that Acrobat Standard 9.0, Acrobat Pro-
fessional, and Acrobat Professional Extended 
all support authoring PDF forms.


You must enter Form Edit mode in order to 
add fields to a document. Choose Forms |  
Add or Edit Fields to enter Form Edit mode.
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26Creating Comb Fields
Comb fields are often found on government forms 
where a user is expected to fill in separate boxes (or 
divisions separated by vertical lines) as a single field 
object.


Comb fields properties are applied to text fields in the 
Text Field Properties dialog box.


To create a comb field, do the following:


	Create a text field in Form Edit mode.


	Open the Text Field Properties dialog box (double click 
the field with either the Select Object tool; open a con-
text menu on a selected field and choose Properties; or 
click Properties in the mini Properties window to open 
the Text Field Properties dialog box).


	Click Options.


	Remove the check marks for Scroll Long Text and Check 
Spelling.


	Click the Comb of check box. 


	Type a value in the charac-
ters text box for the num-
ber of characters you want 
to use in the comb field. 


Sample comb field


Creating Arbitrary Masks
An arbitrary mask might be used for a section number, an  
account number, an identification code or similar type of field. 
The mask can contain alpha and/or numeric characters.


Quite often, you might use an arbitrary mask for an area on a 
form that is used for Official Use Only. If the user needs to fill in 
a field with an arbitrary mask, it’s helpful to add an instruction 
or dialog box informing the user exactly how to fill in the field.


To create a field with an arbitrary mask do the following:


	Create a text field in Form Edit mode.


	Open the Text Field Properties dialog box.


	Click the Format tab.


	Choose Special from the Select format category drop 
down menu.


	Scroll the Special Options list and choose Arbitrary Mask.


	Type a code in the 
field box below the 
Special Options list.


 Sample Arbitrary Mask field 


 


 Note: wildcard alpha characters are A, wildcard numeric 
characters are 9. Any other character retains the character 
in the code.


AA-NNNN
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29
Duplicating Fields on a Page
You can duplicate fields on a page in either Form Edit 
mode or Viewer mode. For a quick method for duplicat-
ing fields, do the following:


 Create one or more fields on a page.


 Select the field(s) with the Select Object tool.


 Press the CTRL/ Option key and drag the field(s) to  
duplicate. 


Adding Fields in Viewer Mode
If you prefer to stay in Viewer mode to create PDF forms, you can 
create a template file having all eight field types. To add field ob-
jects in Viewer mode do the following:


 Open a template file containing all eight field types in Viewer 
mode and click the Select Object tool. 


 Choose Edit | Select All.


 Choose Edit | Copy.


 Choose Edit | Paste.


 Drag the fields to an unobstructed area on your form.


 When you want to add a field, press CTRL/Option and drag to 
position. Click the field with the Select Object tool and choose 
Rename Field from a context menu. Type a new name and con-
tinue adding fields by duplicating and changing field names.


Duplicating Buttons Across Multiple Pages
A common use for a Button with a button face is navigating 
pages. If your files are displayed in Full Screen Mode, you 
may want to add navigational buttons to help the end user 
move around your document.


To create a navigational button and duplicate it across mul-
tiple pages, do the following:


	Add a button to the second page of a multi-page  
document.


	Click the Action tab and add an action to move to the 
next page. You can use either an Execute Menu Item  
action or a JavaScript action to move to the next page.


	Choose Execute a Menu Item from the Select Action 
drop down menu and click Add.


	Click View | Go To | Next Page in the Menu Item dialog 
box.


	Repeat the same steps for a button to navigate to the 
previous page. Click View | Go To | Previous Page in the 
Menu Item dialog box.


	Click OK and Close the Button Field Properties dialog 
box.


	Select both buttons with the Select Object tool.


	Open a context menu on the button and choose  
Duplicate.


	Enter the Page Range in the Duplicate Field dialog box 
(3 to [last page number]). Click OK. The buttons are  
duplicated across the pages specified in the Duplicate 
Field dialog box.
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Adding Button Faces
A button face is an icon or an image appearing within a 
Button field. To add a button face to a Button field, do the 
following:


	Create a button field (in Forms Edit Mode or in Viewer 
mode using the Button tool on the Advanced Editing 
toolbar).


	Open the Button Field Properties dialog box.


	Click the Options tab.


	Choose Icon only from the Layout drop down menu.


	Click Choose icon.


	Click Browse in the Select Icon 
dialog box. Select a file to use for 
a button face.


	 Note that from the Files of type 
(Windows) or Show (Macintosh) 
drop down menu you can choose 
from a number of different file 
formats to import for your but-
ton face. All files compatible with 
the Create PDF | From File menu 
command can be used for a but-
ton face.


	Click Select and click OK.


31 Adding Rollovers to Button Faces
Rollovers for button faces are the same kind of rollover  
effects you see on web pages. When the cursor is placed 
over a button, the icon appearance for the button changes. 
You can use the same effect in Acrobat for button faces.


To create a rollover for button faces, do the following:


 Follow steps on the opposite page to create a button 
face.


 Choose Push for the 
Behavior 


 Click Rollover in the 
State list.


 Click Choose Icon.


 Import another icon for 
the rollover image.


 To proportionally fill 
the button field object 
with the icon image, 
click the Advanced 
button in the Options 
tab in the Button Field 
Properties.


 The Icon Placement dialog box opens.


 Check Fit Bounds and click OK.
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When adding buttons, choose 
from the options in the Behavior 
drop down menu. If you choose 
None, you can eliminate the focus 
rectangle when the button is 
clicked.


ted’s tip
Creating buttons with transparency is 
quite simple. For vector objects use Ado-
be Illustrator. For raster images, add an 
image to a transparent layer in Photoshop 
and save the file as a PDF. All transpar-
ency is preserved with both Illustrator and 
Photoshop layered files.
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Show/Hiding Fields
You can use pop-up button faces to display messages on a 
form. Rather than use precious space on a form for adding 
instructions, use a button to display instructions to help form 
fillers complete your forms.


To add a button face for a help message, do the following:


	Create a button field (in Forms Edit Mode or in Viewer 
mode using the Button tool on the Advanced Editing 
toolbar).


	Add a button face to display a message (see Tip #30).


	Add a button to show the button face. Use the Select 
Action | Show/hide a field action. When you click Add 
the Show/Hide Field dialog box opens.


	Scroll the list of fields and locate the button you want 
to show. Click the Show radio button and click OK.


	Create a second button to hide the field. In the Select 
Action pull-down menu choose Show/hide a field and 
click Add. 


	Scroll the Show/Hide Field dialog box and click Hide. 


	Click OK.


 Sample button


Formatting Field Appearances
Field appearances for border color, fill color, fonts, and font 
sizes are controlled in a field's Properties window in the 
Appearances tab.


You can select one or several fields in either Form Edit 
mode or Viewer mode and change field appearances. 
There are some issues you should know when attempting 
to change appearances. These include:


	To remove a line style (for 
example a Beveled style) 
first select a Border Color 
and choose Solid, then 
choose None from the 
popup color swatch.


	Fonts can be changed on 
multiple fields of different 
types except Radio Buttons 
and Check Boxes.


	Setting the font size to Auto automatically adjusts font 
size to the height of the field box. To use a standard 
size for all fields on a form, choose a fixed point size.


33
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You can nest actions in a field's 
Actions tab. If you want to show 
both the button face and the but-
ton that executes a show or hide 
action, add one action then return 
and add a second action to show/
hide a second button.


You can change default appearances for 
different field types by first making your 
appearance choices in the Appearance 
tab, then open a context menu on a field 
having the new appearance. From the menu 
commands choose Use Current Properties 
as new Defaults. The new defaults remain in 
effect until you change them again.


ted’s tip
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35 Creating Mutually Exclusive Check Boxes
Mutually exclusive check box fields are created for the same 
reasons that you create mutually exclusive radio button 
fields. Only one choice can be made in a group of fields  
having the same name but different export values.


To create mutually exclusive check box fields, do the  
following:


 Select the Check Box tool from the same location as 
you select the Radio Button tool.


 Click to drop a field on 
a form. Note that the 
Check Box options do 
not provide a choice 
for setting the export 
value (Button Value 
when creating radio  
buttons). 


 Click Show all Properties to open the Properties  
window.


 Click Options and type a name for the Export Value.


 Leave the Properties window open with the Option 
tab in view and with the Select Object tool, press 
CTRL/Option + click drag the first check box to a new 
location.


 Type a new name for the Export Value. Continue  
adding fields having the same name but with different 
export values.


Radio buttons and check boxes are identical in  
Acrobat with two exceptions, and don't let anyone tell 
you differently. Radio buttons can have a circle border 
and when you mark a radio button by clicking it, you 
cannot remove the mark by clicking the same button 
again. Check boxes don't have circle appearances 
and when you mark a check box you can remove the 
check mark by clicking the same field again.


ted’s tip


Creating Mutually Exclusive Radio Buttons
One continuing problem forms authors have experienced 
is with creating mutually exclusive radio buttons and 
check boxes. A mutually exclusive field is a radio button 
or check box among a group of fields designed for the 
form filler to make a single choice. As one radio button/
check box is clicked, all other radio buttons/check boxes 
are cleared of marks.


Acrobat 9 has introduced some new features to help form 
authors create mutually exclusive radio buttons. To use the 
new features, do the following:


 Open a form in Form Edit mode.


 Click the Radio Button tool in the Form Edit mode 
toolbar or choose Radio Button from the Add New 
Field drop down menu.


 Move the cursor to the area where you want the radio 
button to appear and click to drop the field on the 
form.


 Type a name for 
the field and type 
an export value.


 Click Add another 
button to group 
and the cursor is 
loaded with the 
Radio Button tool.


 Click to drop the second radio button. By default the 
name appears the same as the first button you cre-
ated. Type a new Button Value and click Add another 
button to group to add additional buttons.
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Submitting Forms to eMail Addresses
To create a Submit Form button, do the following:


	Add a button on a form.


	Open the Button Field Properties dialog box and click 
the Actions tab.


	Choose Submit a form from the Select Action drop down 
menu.


	Click Add.


	Type an eMail address in 
the top field in the Submit 
Form Selections dialog 
box. The syntax for the line 
of type is:


 mailto:<your email address>


	Check an export format 
and click OK.


37Adding a Reset Button
To add a button to reset the form fields, do the following:


 Create a Button field in Form Edit mode.


 Click Properties after dropping the button field.


 Click the Actions tab in the Button Field Properties 
window.


 Choose Reset a form in the Select Action menu.


 Click Add.


 Check the fields you want 
to reset in the Reset a 
Form dialog box.


 Click OK.


A much better way to reset a form 
is to use a JavaScript. You have a 
much easier way to identify fields 
to clear data if you name the 
fields properly. See the JavaScript 
section for the script to show/hide 
fields.


ted’s tip


25


If you want the PDF  
returned to you by Adobe Reader 
users, be certain to enable the 
form with Adobe Reader usage 
rights before sending your form to 
Reader users.
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Placing Multiple Fields
One thing to remember when creating tables in Acrobat is to 
avoid using hierarchical names when using the Place Multiple 
Fields command. In most cases, you’ll want Acrobat to rename 
the first row fields with parent/child names when it  
automatically populates a table.


To create a table, do the following.


 Choose Forms | Add or Edit Fields to enter Forms 
Edit mode.


	Add text fields across a row or column and format the 
fields —especially the number fields.


 Select the fields with the Select Object tool and open 
a context menu.


 Choose Place Multiple Fields.


 Enter the number of rows and columns you want for 
the table in the Create Multiple Copies of Fields  
dialog box and click OK.


39Formatting Numbers
If you add calculations to fields you must format the fields 
as numbers. Before writing JavaScripts, using Simplified 
Field Notation, or using the formula presets, be certain 
to format all the fields containing numeric values to a 
number format. 


To format text fields as number containers do the  
following:


	Create a text field in Form Edit mode.


	Open the Text Field 
Properties dialog box 
(double click the field 
with the Select  
Object tool or open 
a context menu on 
a selected field and 
choose Properties to 
open the Text Field 
Properties dialog 
box).


	Click the Format tab.


	Choose Number from 
the Select format 
category menu.


	Select options for the number attributes. 


Item Price Qty Amount


Total


To learn how to straighten up rows and columns, 
see Tip # 40.


When calculating the rows (or columns) count 
the total number of rows/columns you need. 
Inasmuch as Acrobat is telling you it's copying 
selected fields, it's actually creating a new set of 
fields. The table above would require typing 4 for 
the number of rows (excluding the Total row).


If you want negative values 
reported in red text and/or 
in parentheses, check the 
boxes that apply in the  
Format tab below the  
Number format choices. 


ted’s tip


ted’s tip
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Managing Fields
When you create tables as shown in Tip #39, the fields 
may not fall within the table area of your design. With a 
few short steps using context menus you can align fields 
to any table design.


	After populating a table as described in Tip #39, 
you may need to straighten up the fields so they fit 
within the table cells.


	Select the last row (or column) of fields and move them 
to position in the last row (or column) of your design.


	Drag through the first column (or row) to select only one 
column (or row) of fields.


	Open a context menu and 
choose Align, Distribute 
or Center | Distribute 
Vertically (or Horizontally).


	Select the next row (or 
column) and perform the 
same steps.


 


 Additional context menu commands appearing when 
you open the menu on selected fields include aligning 
fields, sizing fields, and centering fields.


 


 


41Copying/Pasting Blocks of Fields
If you have a group of Fields for identifying information for 
two separate blocks of fields and you want to copy/paste 
the fields on the same form, do the following:


	Create one block of fields and add all the appearances 
and formats you want for the individual fields. Be certain 
to use hierarchical names for the fields such as  
employee.first, employee.last, employee.address, etc.


	Save the form and in the Fields panel choose Sort |  
Alphabetically in Form Edit mode.


	Edit the parent name (in this example employee) and 
change it to a parent name you'll use in another block 
such as emergency for emergency contact data.


 You currently have the saved file with the parent name 
employee and on the clipboard you have the edited  
parent name emergency.


	Choose File | Revert to revert to the saved file. (Note: 
You must be in Viewer Mode to use Revert).


	Choose Edit | Paste and drag the fields to position. The 
pasted fields have different field names and can accept 
unique data.
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Note: If you try to select all fields in 
a table and distribute them together 
(instead of one column at a time) 
Acrobat will cascade the fields. You 
must use the Distribute command 
only on fields selected in one row or 
one column.
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43Setting Tab Orders
Acrobat 9 provides some new exciting ways to set tab 
orders. To explore some of the options you have for setting 
tab orders , do the following:


	To show the tab order on a form, open a populated 
form in Form Edit mode. Open the Tab Order pull-
down menu in the Fields panel (in Form Edit mode) and 
choose Show Tab Numbers. Each field is marked with a 
number signifying the order of the tabs.


	To order fields in a tab order, open the Tab Order drop 
down menu in the Fields panel and choose one of the 
listed orders.


	To manually set tab orders, open the Sort pull-down 
menu in the Fields panel and choose Tab Order. Click 
and drag fields up or down to reorder them. 


Marking Fields Required
If you want to be certain a form filler completes all fields 
on a form prior to submitting the form, you can mark the 
fields Required. When a form filler clicks a submit button 
the submit action won't be invoked if all required fields 
are not filled-in.


In Acrobat 9 you have several ways to mark fields as  
Required.


	When you add a field using a 
Form tool in Form Edit mode 
the mini Properties window 
displays a check box for  
Required. Click the check box 
and the field is marked as  
Required.


	In Either Viewer mode or Form Edit mode, select a field and 
open a context menu. From the menu choices select Set 
as Required Field. The field is marked as Required without 
opening a Properties window.


	In Either Viewer mode or Form Edit mode, select a field and 
open a context menu. From the menu choices select  
Rename Field. The same window opens as when creating a 
new field where you can mark a field as Required.
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Don't open a field's Properties 
window. You won't find a check 


box for Required in the General tab 
in the Properties window.


Note: You can first sort a tab order by 
making a selection in the Tab Order 
pull-down menu, such as Order Tabs 
by Row, then drag fields to reorder 
them while maintaining the original 
row order for fields you don't move in 
the Fields panel.


ted’s tip


ted’s tip


STOP







ted padova ted@west.net 



working with fields


Adding Barcode Fields
You’ll want to observe a few precautions when creating  
barcode fields.


	Populate a form with all the fields you expect to see on 
the final form.


	Save the form.


	Test the form by filling in all the fields with the most 
amount of data any given field can accept. 


	While the fields are populated with data, add a Barcode 
field (click the Barcode tool in Form Edit mode and draw 
a rectangle on your form).


 Barcodes need to know 
how much data are to 
be added to the code 
to estimate the size of 
the barcode, hence your 
reason for populating the 
form with data. If you see 
an error reported in the 
barcode field, you need 
to remove some fields 
from the barcode  
calculation.


	Click the Value tab in the Barcode Properties dialog box.


	Click pick to open the Field Selection dialog box.


	Uncheck boxes for the fields that you don’t need added 
to the barcode.


Get the scoop on


Commercial


AIX
http://www.acrobatusers.com
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Copy the text from the comment note and paste into a text editor. Save the file as a text only file with a .js 
extension and copy to your Acrobat JavaScripts folder.
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Spawning Pages from Templates


Overlay:


	Click to spawn a page overlaying this page.


Appending pages:


	Click to add a new page to this document
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task cannot be executed in 
Adobe Reader
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46 Setting Custom Zoom Levels
When you make adjustments for the Initial View, you choose 
zoom views from a set of preset magnifications.


If you want to use a zoom view other than a preset, you need 
to write a JavaScript to set a custom view.


Here’s how you do it:


	Choose Advanced | Document Processing | Document 
JavaScripts.


	Type a name in the Script Name field box and click 
Add.


	Delete the default text and type:


 this.zoom = 69;


	The above script sets the zoom view to 69% when the 
file is opened.


	Click OK and 
click Close in the 
JavaScript  
Functions dialog 
box and save the 
file.


Using the JavaScript Debugger
The JavaScript Debugger is very helpful when 
writing JavaScripts to report bugs and test lines of 
code.


To enable and use the JavaScript debugger, do the 
following.


	Open the Preferences dialog box. Press 
CTRL/Command + K to open the Preferences.


	Click JavaScript in the left pane. 


	In the right pane check 
the Enable Acrobat 
JavaScript check box.


	Check the Enable 
interactive console 
check box.


	Click OK, to return to 
the Document pane.


To Use the JavaScript 
Debugger:


	Press CTRL/Command + J to open the JavaScript  
Debugger.


	Type a script 
in the Console 
window.


	To run a script, 
select the parts 
you want to test 
and press the 
Num Pad Enter 
key.
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Navigating Views
On a button action do the following:


	Create a Button field.


	Click the Actions tab.


	Choose Run a JavaScript from the Select Action 
drop down menu. 


	Type one of the following scripts in the JavaScript Editor.


 To go to the next page: this.pageNum++;


 To go to the previous page: this.pageNum--;


 To go to a specific page: this.pageNum = 0;


	Click OK in the JavaScript Editor.


	Click Close in the Button Properties dialog box.


48 Creating an Application Alert
Application alerts can help you save some space on a form. 
Rather than adding instructions on the form itself, you can 
create one or more application alert dialog boxes to inform 
users procedures for filling in a form.


To create an application alert, follow these steps: 


	Choose Advanced | Document Processing | Document 
JavaScripts.


	Type a name in the Script Name field box and click 
Add.


	Delete the default text and type  
(without the line numbers):


1. var msg = "Please fill in all form fields";


2. app.alert(msg);


	Whatever text you add between the quotes in line 1 
will appear in the dialog box.


	Click OK, click Close in the JavaScript Functions dialog 
box, and save the file. Upon saving the file, the dialog 
box should appear and give you a preview of the  
application alert.


The above script opens the alert dialog 
box each time the file is opened be-
cause the script is added as a  
Document JavaScript.


The same script could also be added 
to a Page Action (open the Properties 
dialog on a Page in the Pages Panel 
and click Action and add the script in 
the same manner), a bookmark, a  
button, or a Document Action.


ted’s tip
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Keep in mind that JavaScript is zero based. 
Therefore if you want to write a script that 
opens page 7 in a document, your script needs 
to be written as:


this.pageNum = 6;


ted’s tip
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Dismissing Application Alerts
At times you'll want to alert a user when a docu-
ment is first opened. However, if a user opens 
your form several times and continually sees the 
same dialog box appear each time the file opens, 
it can become quite annoying. 


To provide a user an option to dismiss the  
application alert, use the example code below on a Document 
Level JavaScript (see Tip #48 for adding a Document Level 
JavaScript):


 1. if(typeof(global.bShowWarning1) ==  
"undefined")


 2. {


 3. global.bShowWarning1 = true;


 4. global.bPersistWarn1 = false;


 5. }


 6. if(global.bShowWarning1)


 7. {


 8.  var oCk = {bAfterValue:false};


 9. app.alert({cMsg:"Instructions: Fill 
out this form carefully and click 
the Submit Form button when fin-
ished.", nIcon:1,oCheckbox:oCk, 
cTitle:"Reminder"});


 10. global.bShowWarning1 = !oCk.bAfterValue;


 11. }
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Adding Line Breaks to Alerts
You might want to format the text a little in an alert dialog box 
to emphasize a line of text. By adding a few control switches you 
can easily add line breaks to messages in application alert dialog 
boxes.


Here's a sample script that adds a line break.


 1. var msg = "Here's a script with a line breaks.\n\nVis-
it my blog at\n\nhttp://www.acrobatusers/blogs/ 
tedpadova"


 2. app.alert(msg);


 In line one the \n\n coding creates the line break.


Invoking Actions on Field Entry
Actions such as application alerts, calculations, and a variety of 
other action types can be invoked when a user tabs into a field.


To add a JavaScript when a user tabs into a field, do the following:


	Open the field properties on the field where you want the  
action to be invoked.


	Click the Actions tab.


	Open the Mouse Trigger drop down menu and choose On 
Focus. This option sets the action to when a user tabs into 
the field.


	Choose Run a JavaScript from the Select Action drop down 
menu and click Add.


	Type your script in the JavaScript Editor.
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Assessing Viewer Versions
Some features in Acrobat viewers 6, 7, 8, 9 and above 
may not be available to users of earlier versions of  
Acrobat. To help a user understand if a feature won't 
work in an earlier version, you can have Acrobat assess 
the viewer version and report in an application alert 
dialog box a message if it detects a version lower than 
one you want to specify in the code. 


To write a script that assesses viewer versions, add the  
following script to a Document Level JavaScript:


 1. //is the viewer version less than 9.0


 2. if(app.viewerVersion < 9.0)


 3. {


 4. var msg = "Some features won't work in  
Acrobat viewer versions less than version 9.0.";


 5. app.alert(msg);


 6. }


Assessing Viewer Types
Another assessment function available to you in Acrobat is 
assessing the viewer type. This code should be added to 
forms that have certain actions that can't be executed in 
Adobe Reader. 


To write a script that assesses viewer types, add the follow-
ing script to a Document Level JavaScript:


 1. //is Adobe Reader as opposed to Adobe Acrobat


 2. if(app.viewerType == "Reader")


 3. {


 4. var msg = "Filling out this form requires  
either Adobe Acrobat Pro or Adobe Acrobat  
Standard";


 5. app.alert(msg);


 6. }


54
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Line 1 in the above code is a comment 
line. When you see a line preceded by // 
remember that the line has no effect on 
executing the script.


It's a good idea to add comments so 
that when you want to later review some 
of your code it will be much clearer to 
you.


Many of the scripts in this document 
won't have comments due to space 
limitations. 


If you want to assess both  
viewerVersion and viewerType, you can 
add both scripts to a  
Document Level JavaScript.


Simply add the above script following 
line 6 in the viewerVersion script.


ted’s tip ted’s tip
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Assessing Document Information
You can use JavaScript to report back to you certain 
information about a document such as Title, Author, 
Subject, Keywords and more. 


To write a script that reports the PDF author on a button 
action, do the following:


 1. var f = this.getField("textField");


 2. f.value = ("Author is: " + this.author);


Line 1 identifies the text field where the information will be 
reported. The script is written on a button and when clicked the 
author of the PDF is shown in the text field.


Coding for other information that can be reported in the 
JavaScript Console (see Tip #45 for more on using the 
JavaScript Console) or within a text field includes:


this.title; // title field


this.subject; // subject field


this.keywords; // keywords field


this.producer; // PDF producer application


this.creator; // authoring document


this.creationDate; // date PDF was created


this.modDate; // date PDF was modified


this.pageNum; // page number of current page


this.numPages; // number of pages in the PDF


this.filesize; // the file size of the PDF


this.path; // directory path for file location


this.numTemplates; // # of templates in the PDF


this.numFields; // number of fields in the file


Auto-tabbing Fields
You can set up fields with auto-tabs so that when a user 
completes filling in a field, the cursor jumps to the next field. 
You might use this feature if you have a SS number or phone 
number where the numbers are completed in separate 
fields.


To set up an auto tab, do the following:


	Write a Document Level JavaScript and enter the  
following code:


 1. function goNext(item, event, cName)


 2. {


 3.  AFNumber_Keystroke(0, 0, 0, 0, "",true);


 4.  if (event.rc &&


 5.  AFMergeChange(event).length ==event.target. 
 charLimit)


 6.  item.getField(cName).setFocus();


 7. }


	Create three fields (tel.1, tel.2, tel.2) and set the limit 
of characters in the Options tab to 3 for the first field, 
4 for the second, and 3 for the third. I'll use a Social 
Security number as an example.


	Open the Format tab in the first field properties and 
click the Custom Keystroke Script radio button and 
click Edit.


	In the JavaScript Editor, add the following code.


 1. goNext(this, event, "tel.2");


 In the above script, tel.2 is the next field that follows 
the field where the script is written.


	Repeat the same steps for the second field and jump 
to the next field (tel.3).
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Printing Pages Via JavaScript
Adding buttons to print pages is particularly useful 
when your forms are displayed in Full Screen mode. 


To write a script that prints the current page in view, use 
the following script on a button field:


 1. this.print (false, this.pageNum,  
this.pageNum, {bShinkToFit: true});


The false item in the above script prevents the Print dialog box 
from opening and the page is sent directly to the printer. The  
{bShrinkToFit: true} item shrinks the page to fit within the paper 
size if the PDF page is larger than the output page size.


To print all pages in a document, use:


 1. this.print(true);


Printing from the JavaScript Console
If you happen to be viewing a file in Full Screen mode 
and you want to print a page or the entire document 
while remaining in Full Screen mode, you can use the 
JavaScript Console.


To print a document while in Full Screen mode, do the 
following:


	Press Command/CTRL + J to open the JavaScript Editor.


	In the JavaScript Console type the following code to 
print the entire document.


  1. this.print(true);


	Press the Num Pad Enter key on your keyboard.


Eliminating Fields From Print
You may want to print a document without the data in 
certain fields to be printed on the output. Use the Form 
Field drop down menu in the General tab in the Document 
Properties and choose Visible but doesn't print and the field 
won't print on the output.


If you have some conditional items where if X occurs, 
then you don't want certain fields to print, you can use a 
JavaScript to control whether fields print or not. 


To do so, use the following example:


	On a button field create a JavaScript and enter the fol-
lowing code:


  1. var f = this.getField(myFfield");
   // myField is the field name
  2. f.print = false;


Printing with Annotations
If you want to print a file with the annotations added to the 
output, use the following JavaScript on a button field:


	Create a button field and add a JavaScript using the 
following code:


  1. this.print (true, {bAnnotations:  
 true, bShrinkToFit: true, bReverse: true});


	The above code is used to print annotations and the  
bShrinkToFit toggle is on as well as printing in reverse 
order. To eliminate any of the items, delete those not 
desired from the code.
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Date Stamping a Document
You may want to date stamp a form at the time a user signs 
the form or submits the form. 


You can add a JavaScript on a signature field or a button. 
Use the following example to add a date stamp when a user 
signs a form:


	Create a Signature field on a form and click the Signed 
tab in the Signature Properties dialog box.


	Click the This field executes when the field is signed 
radio button and click the Edit button.


	Type the following script in the JavaScript Editor:


 1. var f=this.getField("date");{


  f.value = (new Date()).toString();


  AFDate_FormatEx("h:MM tt, mmm dd, yyyy");


   }


date in the script above is the name of the field where the 
date will be added.
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Creating Document Actions
You can execute JavaScripts during certain document 
actions such as saving a file, printing a file, or closing a 
file. You may want to add an application alert when a file 
prints to provide the user instructions on what to do with 
the form after printing it.


To write a script on a Document Action, do the following:


	Choose Advanced | Document Processing | Set  
Document Actions.


	Choose an action in the scrollable list (for example  
Document Will Print).


	Click Edit to open the JavaScript Editor.


	Add an application alert in the JavaScript Editor such as 
the example shown:


 1. var msg = "Please deliver printed copy to  
accounting";


  2. app.alert(msg);
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Summing Rows and Columns
The easiest way to sum a column or row is to not write a 
JavaScript and use the built-in formula for summing data 
that Acrobat provides you. To use the built-in formula for 
summing a series of data fields, do the following:


	Create a column (or row) of fields formatted as 
numbers.


	Be certain to name the fields with hierarchical names 
such as amount.0, amount.1, amount.2, etc.


	Double-click the field that records the data sum with the 
Select Object tool to open the field properties dialog 
box.


	Click the Calculate tab.


	Choose sum(+) from the Value is the drop down menu.


	Click the Pick button.


	Check the box where you see the parent name in the 
Field Selection dialog box.


	Click OK.


When you return to the Calculate tab in the Text Field  
Properties, you should see the parent name shown in the field 
box below the Value is the drop down menu.


64 Using Simplified Field Notation
Acrobat offers only a limited number of built-in formulas. If 
you want math functions such as division and subtraction, 
you need to use either JavaScript or Simplified Field  
Notation (SFN).


Simplified Field Notation is a much easier scripting language 
based on syntax similar to formulas written in spreadsheets. 
To calculate a sum and add a sales tax using SFN, do the 
following:


	Open a text field properties for a total field and click  
Calculate.


	Click the Simplified field notation radio button and 
click the Edit button.


	Type the following script in the JavaScript Editor:


 1. (item0 + item1 + item2 + item3) + ((item0 + 


item1 + item2 + item3) *.00725)


	The above script sums data in fields item0, item1, and 
item2 and adds a sales tax of 7.25%. Note that the 
fields all have separate names and do not use parent/
child names.
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You cannot use hierarchical 
names with Simplified Field 
Notation.
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Summing Data with JavaScript
You may want to sum data in a column or row and add 
a sales tax to the sum, a shipping charge, apply a dis-
count, or some other math function as part of the field 
calculation. 


If you use the built-in formula described in Tip #63 you 
can't add a second calculation. If you use a Simplified 
Field Notation script, you need to name each field 
separately in the formula —something that could be very tedious 
with long columns or rows. 


In order to extend the formula to calculate a total and apply the 
total to another calculation, your best option is to use JavaScript.


	Open the Calculate tab on a field to hold the data calculation 
and click Edit for Custom Calculation Script.


	In the JavaScript Editor, type the following code:


 1. var f = this.getField("amount");


 2. var a = f.getArray();


 3. var sum = 0;


 4.   for (i =0; i < a.length; i++)


 5.   sum += a[i].value;


 6. event.value = sum + (sum * .08);


Line 1 sets up an array with a field having a parent 
name of amount. The form contains several fields named amount.0, 
amount.1, amount.2, etc. The loop is executed and picks up the 
value for each field and adds it to a variable called sum. 


The last line adds the sum to the sum * a sales tax of 8%.
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Calculating a Sales Tax
Sales tax calculations can be handled easily with built-in 
formulas, Simplified Field Notation, and JavaScript when you 
have separate fields for a subtotal and a tax field.


Using JavaScript the following script would be used to  
calculate a sales tax:


	Open the Calculate tab on a field to hold the data cal-
culation and click Edit for Custom Calculation Script.


	Type the following script in the JavaScript Editor:


 1. var f = this.getField("subtotal");


 2. event.value = Math.round(f.value * 7.25) / 100;


	The above script assigns a variable to a field called 
subTotal where the sum of data in a row or column is 
calculated. The second line of code calculates a sales 
tax of 7.25%.


Calculating a Shipping Charge
A shipping charge might be calculated based on the total 
cost of items purchased. The following formula calculates a 
shipping charge of 12% of the total purchase amount. 


	Open the Calculate tab on a field to hold the data cal-
culation and click Edit for Custom Calculation Script.


	Type the following script in the JavaScript Editor:


 1. var g = this.getField("subtotal");


 2. event.value = Math.max(2, Math.floor(g.value / 
12));


	The above script assigns a variable to a field called 
subTotal where the sum of data in a row or column is 
calculated. The second line of code calculates a  
shipping charge of 12%.
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Importing Images
You may want to add a photo or logo to a form that  
permits the user to import an image on a button action.


Here's how to do it:


	Create a button field and choose Icon only in the 
Options tab.


	Click the Actions tab and add a JavaScript.


	In the JavaScript Editor, type the following code:


 1. event.target.buttonImportIcon();


 When the form filler clicks the button, the Select Icon 
dialog opens.


 
Showing/Hiding Fields
Acrobat provides you an action to show and hide fields. If you 
have many fields to show/hide, you need to check each item in 
the Show/Hide Field dialog box. An easier way to handle the 
task is to use JavaScript. 


	Create a button field and click the Actions tab and add a 
JavaScript.


	In the JavaScript Editor, type the following code:


 1. var f = this.getField("myField");//parent name


 2. f.hidden=true;//hides all fields with the same 
parent name


70 Resetting a Form
Acrobat has a built-in function for resetting a form. This  
action works fine when you want to reset all fields or all  
fields with a few exceptions on a form.


You may have different sections of a form that you don't 
want to reset such as the identifying information or fields 
that contain fixed data that you use for calculations. 


Using JavaScript the following script would be used to reset 
form fields having the same parent name:


	Create a button and add a JavaScript.


	Type the following script in the JavaScript Editor:


 1. var resetFields = this.getField("customerData");


 2. this.resetForm(resetFields);


	The above script resets the fields with the parent name 
of customerData.
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To show hidden fields use the  following script in line 2:


 2. f.hidden=false


For an example of extensive use of showing and hiding 
fields, see the companion file in this portfolio.


ted’s tip


If you want to reset all fields on a form, use the 
following script:


 1. this.resetForm();


This kind of script might be added as a Document 
Level JavaScript or Page Action script along with 
an Application Response dialog box that prompts 
the user to reset a form.


If a user partially completes an order form, the user 
would say no to resetting a form. If the user starts 
anew, then perhaps all the data might be reset on 
the form.
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Setting Fields to Read Only
Fields that are set to Read Only in the General tab of the 
field properties dialog box, prevent data entry or changing 
the field data by an end user. If the form is secured with 
Acrobat Security, the user won't be able to edit the fields 
and change the data.


You might set fields to Read Only that have fixed price 
values and calculations.


To set a field for Read Only, do the following:


	Open the properties dialog box on any field.


	Click the General tab.


	Check the box for Read Only.


72 Deleting Fields
Deleting fields can provide another level of security on a 
form. When a user submits a form or prints a form, you can 
delete all fields with no data. Something like a travel reim-
bursement form might be one example of a form where 
deleting fields could be used. 


If there are no fields to add data, the form can't be changed 
by another user.


Using JavaScript the following script would be used to  
delete a series of fields containing no data:


	Add a JavaScript to a Signature Field, a Document  
Action, or a Submit button.


	Type the following script in the JavaScript Editor:


1.  for (var i = 0; i < 5;i++) 


2.   {var f = this.getField("amount."+i);


3.   if (f.value == "")


4.   removeField("amount."+i);


5.  }


	The above script deletes all fields with the parent 
name of amount that have no data.
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You might start with fields that are marked for read-
ing and writing and later, after the user executes 
certain actions, you might want to lock the fields 
to prevent data entry. To handle this task add a 
JavaScript in the Calculate tab where you want the 
field marked as Read Only.


Here's a sample:


 1. var f = this.getField("item")


 2. f.readonly=true;


All fields with the same parent name are marked as 
Read Only.


To disable Read Only, use the following in a script 
like the above:


 2. f.readonly=false;
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Deleting Zeros from Calculation Fields
If you have a table and the last column or row of data is 
a calculated field (something like price * qty), the default 
result is 0.00 until data are added for the fields within the 
calculation. 


You can eliminate default zeros in calculated fields with 
JavaScript.


Example script:


 1. var f = this.getField("price.0");


 2. var g = this.getField("qty.0");


 3. if (g.value !=0)


 4.  event.value = f.value * g.value;


 5. else


 6.  event.value ="";


In lines 1 and 2 the variables are assigned for a price and  
quantity field. The result of the calculation is an amount  
determined by multiplying the price * the quantity.


Line 3 checks the qty field and if it's not zero, the calcula-
tion is performed. If the result is zero, line 6 is executed 
where no value is entered in the field resulting in  
eliminating default zeros.
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Adding URLs to Text
Text added to a background design that contains a URL or 
email address is automatically recognized in Acrobat  
viewers 7 and above. There's no need to add links or buttons 
to navigate to a URL or open your default email client on a 
button click.


However, if you ask a user to add a URL to a text field, the 
text field isn't recognized as a URL link. Using JavaScript, you 
can create the link by doing the following:


	Create a Text field in Form Edit mode.


	Open the Actions tab and choose Mouse Up for the 
Mouse Trigger. This trigger will execute the action 
when a user clicks on the text field.


 Add a JavaScript in the Action tab and type the  
following in the JavaScript Editor:


 1. if ( !/^\s*$/.test(event.target.value) )
    app.launchURL(event.target.value);


	The next time a user clicks in the text field, the URL 
opens in the user's default Web browser.


URL Links in New Windows
By default, a URL link opens in the same window if the 
browser is open and displays a web page. Using JavaScript 
you can force a URL link to open in a second window:


	On a link button or any field containing a URL link use 
the following script:


 1. app.launchURL(“http://www.mycompany.com/file.
pdf”, true);


The true statement in the above code triggers opening the 
link in a new browser window.
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Note that you cannot eliminate zeros 
using the built-in formulas or Simplified 
Field Notation. You must use JavaScript 
in order to eliminate the zeros.
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Adding Annotations Using JavaScript
You might have a need for a user to add a comment 
note, add a Stamp comment, or a Text Box comment 
based on a conditional response.  
 
Perhaps clicking a check box where the item is Other 
among a list of other options is one example where you 
might use this feature. If the check box is clicked, a Text 
Box is added to the document page or some such other type of 
condition.


Note that the file must be enabled with Adobe Reader usage 
rights for this to work in Adobe Reader.


	Add a JavaScript to a button, a check box, or radio  
button and click the Actions tab.


	Type the following in the JavaScript Editor:


 1. var annot = this.addAnnot({


 2.  page: this.pageNum,


 3.  type: "FreeText",


 4.  rect: [396,298,629,406],


 5.  strokeColor: color.white,


 6.  fillColor: ["RGB", .85, .85, .85],


 7. }


Line 3 identifies the type of annotation to be added to the 
page. In this example FreeText is a Text Box comment.


Line 4 specifies the Text Box rectangle coordinates. You need 
to precisely determine where the coordinates are for the anno-
tation you want to add using the script (See Tip #78 for how to 
determine x,y coordinates). Lines 5 and 6 set attributes for the 
border color and the fill color of the Text Box.


77 Adding Fields Using JavaScript
You can add fields using JavaScript. You might add a field for 
user input based on a user response.


This task cannot be performed in Adobe Reader when forms 
are created in Acrobat. However, you can create dynamic 
forms in Adobe LiveCycle Designer that enable Adobe 
Reader users to spawn fields on a page.


Example script:


 1. var f = this.addField("newField", "text",


 2.   page = this.pageNum,[100,100,200,200])


 3.   f.textSize = 9;


 4.   f.textfont = font.Helvtica;


 5.   f.textColor = color.white;


 6.   f.fillColor = new Array("RGB", .9, .9, .9);


 7.   f.alignment = "left";


 8.   f.multiline = true;


 9.   f.readonly = false;


Line 2 identifies the x,y coordinates for the field rectangle. 
Before writing the script, be certain to identify the exact 
coordinates where you want the field to appear.


See Tip #78 for an easy method for identifying x,y  
coordinates.
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Determining x,y Coordinates
Tips #76 and #77 use x,y coordinates to determine the 
bounding box for annotations and fields. Before you 
start writing a script you need to know the coordinates 
for where you want the object to appear on the page. 
 
To easily determine the coordinates you'll use in your 
JavaScript code, do the following:


	Open the Comment and Markup toolbar.


	Click the Rectangle Comment tool.


	Draw a Rectangle comment in the area of your form 
where you want to create an annotation or field.


	Open the JavaScript Console (Command/CTRL + J).


	Enter the following code in the Console.


  1. this.getAnnots()[0].rect;


	Press the Num Pad Enter key on your keyboard.


	The JavaScript Console reports back to you the 
coordinates. 


	Ignore all digits after the decimal point and use 
the whole numbers for the x/y coordinates in 
your script.
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Changing Text Colors
By default, Acrobat permits you to identify negative values 
with a red color in the Format tab. If you want to emphasize 
a value that's not a negative value or use another color other 
than red, you can do so using JavaScript. 


Example script in the Format tab in a text field:


1.  var f = this.getField("fieldName");


2.   if (event.value >50)


3.    f.textColor = color.red;


4.  else


5.    f.textColor = color.black


The above script sets the text color to red if the value in 
a field named fieldName is greater than 50.
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Using Custom Colors
Acrobat provides you with some default colors that you 
can assign to text and objects. If you want to create a 
custom color, look up a color in a program like Adobe 
Photoshop and record the RGB (or CMYK) values. The 
colors in Photoshop use whole numbers to express color.


In Acrobat you define a color by using something like 
["RGB", .503, .982, .495]


To convert the color values from Photoshop to Acrobat, 
take a Photoshop color and divide by 255. Therefore a 
color like a red value of 149 in Photoshop would be a red 
value of .584 in Acrobat. The syntax for changing a color 
in a field would be something like:


1.  event.target.textColor = ["RGB", .503, .982, 
.495];
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Limiting Character Strings
You can limit the number of characters added to a text field 
with a JavaScript. To do so, use the example below:


	Open the Text field properties on a field.


	Click the Format tab.


	Click the Custom Keystroke Script radio button.


	Click Edit and add the following script in the 
JavaScript Editor.


 1. var f = this.getField("myField");


 2. if (event.value.length > 10)


 3.  {


 4.   var msg = "Your entry is too long  
  (limit 10 chars).";


 5.   app.alert(msg);


 6.  }
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Changing OCG States
Optional Content Groups are layers in a PDF document. You 
have available an action to Set Layer Visibility, but there are 
conditions where the action won't work and you need to use 
a JavaScript to change layer visibility.


To examine scripts that change layer visibility open the 
file in this portfolio: housePlansForm.pdf. Look over the 
JavaScripts in this document to discover how to change layer 
visibility using JavaScript.


Spawning Pages From Templates
Spawning pages from templates provides you with  
options for many uses. PDF files can be made more 
dynamic by adding content on-the-fly through new pages 
added to a document.


	Add a page to a document that you want to use for 
a template and navigate to that page.


	Choose Advanced | Document Processing | Page  
Templates in Viewer mode. (Note that you cannot access 
the Page Templates command in Form Edit mode).


	Type a name in the Page Templates dialog and click Add. 
To hide the template from view, click the Eye icon.


 Add a JavaScript to a button field and enter the 
following code in the JavaScript Editor.


 1.  var a = this.getTemplate("myTemplate");


 2.  a.spawn ({


 3.   nPage:this.numPages,


 4.   bRename:true,


 5.   bOverlay:false


 6.  })


Be certain that you use the name you assigned to the template 
in Line 1. When you click the button, a new page is spawned 
from the template.


Sample field:
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By default the bOverlay switch is off 
meaning new pages are added to the 
document. If you want to overlay the 
new page on an existing page (like add-
ing a watermark), set the toggle to true 
as shown below:


4. bOverlay:true,
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Popup Menus for URL Navigation
Popup menus provide you with navigation options that 
can be used when viewing PDF files in Full Screen views. 
The following popup menu item opens different URL in 
your default Web browser.


	Add the following script to a button:


 1. // Declare pop-up properties as an array.


 2. var aParams = [ 


 3.  {cName: "Acrobat User Community", cReturn:  
 "www.acrobatusers.com"}, 


 4.  {cName: "-"},


 5.  {cName: "Acrobat User Blogs", cReturn:  
 "http://www.acrobatusers.com/blogs"}, 


 6.  {cName: "Ted's Blog Site", cReturn:  
 "http://www.acrobatusers.com/blogs/tedpadova"}


 7. ];


 8. var cChoice = app.popUpMenuEx.apply( app, aParams 
);


 9. if ( cChoice != null ) app.launchURL(cChoice); 


The above popup menu works much better than bookmarks if 
you intend to display your form in Full Screen mode.


85 Popup Menus for Page Views
The app.popUpMenuEx object is the preferred way to write 
a script for application popup menus. However, you can get 
by with a much easier script that works well in all Acrobat 
viewers. 


The following example uses a simple method for navigating 
pages in PDF. 


	Navigate to a view you want for a page link to a popup 
menu item.


	Choose View | Navigation Panels | Destinations.


	Click the Create new destination tool in the  
Destinations panel.


	Repeat the steps for creating destinations to all views 
you want to link to in a popup menu.


	Create a button field and add a JavaScript with the  
following code:


 1. var cChoice = app.popUpMenu


 2.  (["First Page", "Home"], 


 3.  ["Second Page", "Samples"],


 4.  ["Third Page", "JavaScripts"],


 5.  ["Fourth Page","URL Links"],


 6.  ["Fifth Page","Sample Forms"]);


 7. this.gotoNamedDest(cChoice);


The first item in steps 2-6 is a parent name that shows a child 
name when the menu is opened. The child names are the 
same exact names as the destination names and a click on 
the name opens the destination view.
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You can add an unobtrusive popup 
menu to a form that provides URLs 
where users can explore more product 
information, contact info, company 
brochures, etc. One button can open 
many links while not disturbing the 
form design.
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Popup Menus for Opening Files
To create a popup menu that opens files, be certain to 
place the files in the same folder as the document con-
taining the popup menu.


Add the following JavaScript to a button:


 1. var cChoice = app.popUpMenu


 2.  (["Human Resource Forms", "hrForm.pdf",   
 "vacationLeave.pdf"], 


 3.  ["Sales Forms", "salesOrder.pdf", "customerID. 
 pdf", "purchaseForm.pdf"],


 4.  ["Administration Forms", "creditApplication 
 Form.pdf", "creditApprovalLetter.pdf"]);


 5. this.slave = app.openDoc((cChoice), this); 


Each of the items (2-4) has multiple submenu items that open 
the respective PDF documents.


Don't forget the semicolon (;) at the end of line 4. Each of the 
other lines of code (2-3) end with a comma.


Emailing a PDF
From a button or a JavaScript assigned to another action you 
can attach the open PDF document to an email message.


On a button field, add the following script:


 1. // use mailDoc in this routine


 2. this.mailDoc(true, "yourname@address.com", "cc 
goes here", "bcc goes here","Subject goes here");


Emailing Form Data
From a button or a JavaScript assigned to another action 
you can attach just the form data from the open document 
to an email message.


On a button field, add the following script:


	1. // use mailForm in this routine


 2. // gets the user address from a field


 3. var f = this.getField("useraddress");


 4. this.mailForm(true, f.value, "", "","Subject");


The above script attaches an FDF form data file to an email 
message. Line 3 picks up an email address from the form 
that the PDF author added to the form and uses that address 
for the To field in a new email message.
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Note that if you want to reference fields on 
a page that have been filled in by you and 
you don't want them to be visible to the 
end user, you can fill in a field and hide the 
field.


Open the General tab in the field properties 
dialog box and choose Hidden from the 
Form Field drop down menu.
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Creating Fixed Response Options
You may have a form where you want a user to make a selection 
from a Combo Box and based on that selection, offer choices 
respective to the first choice in a second Combo Box.


Something like choosing a shirt in one column and have sizes 
appearing in a second column might be one example of such a 
case. If you have shirts, pants, hats, and other articles of cloth-
ing , the choices in the second column will change based on 
the first column choice.


For the script (opposite page) to execute properly, you need 
to create a table with at least two columns (or rows). The script 
is added to the fields in the first column (or row) in the Format 
tab, then duplicated for all subsequent columns/rows.


Do the following to set up the table:


	Create a table with 5 columns as shown below.


	Open the text field properties in the first field in column 
one and click the Format tab.


	Add a Custom Keystroke Script and type the code at 
right in the JavaScript Editor.


 1. if (!event.willCommit) {


 2. var a = this.getField("type.0");


 3. a.clearItems();


 4. switch (event.change) {


 5.  case "Golf Balls":a.setItems(["",  
 "Titlest", "Pinnicle", "MaxFli"]);


 6. break;


 7.  case "Golf Hats":a.setItems(["", "Navy", 
 "White", "Green"]);


 8. break;


 9.  case "Golf Shirts":a.setItems(["", "Small", 
 "Medium", "Large", "Extra Large"]);


 10. break;


11.  case "Golf Shoes":a.setItems(["", "Size 9", 
 "Size 9.5", "Size 10","Size 10.5",  
 "Size 11", "Size 11.5", "Size 12"]);


12. break;


13.  case "Golf Tees":a.setItems(["", "25",   
 "50", "100"]);


14. break;


15. }
Item Type Price Qty Amount


Total
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If you want a fixed price for each item 
selected for Item and Type, add a JavaScript 
in the Calculate tab for the Price field.


Open a price field and you can view the 
JavaScript added here to create the fixed 
prices.
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Creating App Response Dialog Boxes
An application response dialog box typically presents the 
user with a question and solicits an answer. Based on the 
response certain actions can be invoked. You might want 
to ask a user how many products to purchase. The user 
responds and you can then take the data from the dialog 
box and add it to a field object.


To perform such a task, do the following:


	Create a text field.


	Create a button field and add the JavaScript below:


 1. var t = this.getField("qty");  
// the target field 


 2. var cResponse = app.response({ 


 3.  cQuestion: "How many do you want?", 


 4.  cTitle: "Quantity to purchase"});


 5.   if ( cResponse == null){  
  // if Cancel is selected 


 6.   app.alert("Cancel order for this item?");


 7.   cResponse = 0;


 8.   }


 9. else 


10. app.alert("You ordered, \""+cResponse+"\"... 
 items",2);//confirmation dialog


11. {


12. t.value = cResponse; // places the data from the  
dialog to the target field


13. }


Adding Data to Secondary Forms
If you have a product brochure of a large file size, you might 
want to add application response dialog boxes to populate 
a secondary form or copy data from a form page on a prod-
uct brochure to another document you use as an order form.


On a button field, add the following script:


	Create a form and add the following Document Level 
JavaScript:


 1. this.disclosed = true;


	On a button field in another document add the follow-
ing script:


 1. this.slave = app.openDoc("myForm.pdf",this);


 2. this.bringToFront();


 3. for (var i = 0; i <4; i++) {


 4.  var quantity = this.getField("qty."+i);


 5.  var result = this.slave.getField("oQty."+i); 


 6.   result.value = quantity.value;


 7.  var amount = this.getField("total." +i);


 8.  var cResult = this.slave.getField("oAmount."+i);


 9.   cResult.value = amount.value;


10. }


11. slave.bringToFront();
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If you want Adobe Reader users to fill in a 
form apart from a brochure, add the form to 
a PDF Portfolio. Add a submit form button 
and enable the form with Reader usage 
rights. When the Reader user submits a 
form in a PDF Portfolio, only the form is sent 
back to you.
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Menu Items


Scripts cannot be written in 
Adobe Reader, but the menus
created in Acrobat do appear  
in Adobe Reader. 


Tools
Comment & Markup


Select & Zoom
Advanced Editing


Typewriter
Analysis


Multimedia
Customize Toolbars


Page Templates
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About Adding Menu Commands
You can add custom menu commands in Acrobat and the 
same commands you create in Acrobat are also usable in 
Adobe Reader.


To create a custom menu command you need to add a 
JavaScript to your JavaScripts folder.


On Windows the directory path for the JavaScripts folder 
is: Program Files/Adobe/Acrobat 9.0/Acrobat/JavaScripts


On the Macintosh the path is: Users:User Log-on/ Library/  
Acrobat User Data/90_x86/JavaScripts


Copy the file attachments in this document to the JavaScripts 
folder on your computer.


Save your text files with a .js extension.


Add a menu command that counts the total fields on a from. 
This can help compare forms, diagnose forms, and provide 
information on forms that have been secured with Acrobat 
Security.


When you select the menu item, a dialog box opens reporting 
the find.


	Write a JavaScript with a text editor using the following 
code:


 1. function totalFields(){


 2. app.alert("Total Fields: " + this.numFields);


 3. }


 4. app.addMenuItem ({cName: "Number of Fields",


    cParent: "Tools", cExec: "totalFields()"


 5. });


The above script adds the menu command to the Tools menu (line 4).


Counting Page Templates
Add a menu command in the Tools menu that counts Page 
Templates. Counting Page Templates can be helpful in diag-
nosing forms and provide information about forms that have 
been secured with Acrobat Security.


  Write a JavaScript with a text editor using the  
 following code:


 1. function totalTemplates(){


 2.  app.alert("Total Page Templates: " + this. 
 numTemplates);


 3.  }


 4.  app.addMenuItem ({cName: "Page Templates",


    cParent: "Tools", cExec: "totalTemplates()"


 5. });


The above script adds the menu command to the Tools 
menu (line 4).


93
51


You can add both menu commands in Tips 
#92 and #93 in the same script. Copy lines 
1-3 in one script and paste it after line 3 in 
the first script. Then paste lines 4-5 at the 
end of the first script.


Check out the file link in this portfolio and 
copy the tools.js content to your JavaScript 
folder and you won't need to write the 
scripts.
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Listing Menu Items
It you want to access a menu command using JavaScript 
or add a menu item, you need to know the menu items 
names used by JavaScript. 


To view a list of menu item names, do the following:


	Open the JavaScript Console (Command/CTRL + J).


	Type the following code in the Console:


 1. app.listMenuItems();


	Press the Num Pad Enter key and all the menu item names 
are shown in the JavaScript Console.


Adding a URL to a Menu
You can add menu commands that open URLs in your de-
fault Web browser.


Here's the JavaScript code for accessing the FedEx/Kinkos 
web site to order prints. Replace the URL in this script with 
your favorite print service.


 Write a JavaScript with a text editor using the following 
code:


 1. app.addMenuItem({


 2. cName: "FedExKinkos",


 3. cParent: "Help",


 4. cExec: "app.launchURL('https:// 
partner.fedexkinkos.com/partnerInit.do');",


 5. nPos: 16


 6. });


Line 5 in the above code positions the command in the Help 
menu. You may want to change the position by typing a  
different value.


When the menu com-
mand is selected your 
default Web browser 
opens and takes you to 
the target URL.


Copy the code from 
the kinkos.js file in this 
portfolio.
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To display toolbar buttons, type the  
following in the JS Console:


app.listToolbarButtons();
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Add a File | New Menu Command
Acrobat provides you an option to create new blank pages. 
However, the new pages by default have a text block that can 
be annoying when you want to use blank pages for temporary 
documents to hold form fields.


With a little JavaScript you can create the missing File | New 
command that Acrobat has avoided through 9 generations. 
The following code creates the command with several different 
custom page size options:


	Type the following code in a text editor and save the file to 
your JavaScript folder with a .js extension:


 1. trustedNewDoc = app.trustedFunction( function 
(nWidth, nHeight)


 2. { 


 3. app.beginPriv(); 


 4. switch( arguments.length ) { 


 5. case 2: 


 6. app.newDoc( nWidth, nHeight ); 


 7. break; 


 8. case 1: 


 9. app.newDoc( nWidth ); 


 10. break; 


11. default: 


12. app.newDoc(); 


13. } 


14. app.endPriv();


15. })


16. app.addSubMenu({ cName: "New", cParent: "File", 
nPos: 0 })


17. app.addMenuItem({ cName: "Letter Portrait", cPar-
ent: "New", cExec: "trustedNewDoc();"});


18. app.addMenuItem({ cName: "Letter Landscape", cPar-
ent: "New", cExec: "trustedNewDoc(792,612);"});


19. app.addMenuItem({ cName: "A4", cParent: "New", 
cExec: "trustedNewDoc(420,595)"});


20. app.addMenuItem({ cName: "Slide (10x7.5)", cParent: 
"New", cExec: "trustedNewDoc(720,540);"});


21. app.addMenuItem({ cName: "Screen (640x480)", cPar-
ent: "New", cExec: "trustedNewDoc(640,480);"});


22. app.addMenuItem({ cName: "Note (4x3)", cParent: 
"New", cExec: "trustedNewDoc(288,216);"});


23. app.addMenuItem({ cName: "Custom...", cParent: 
"New", cExec: 


24. "var nWidth = app.response({ cQuestion:'Enter Width 
in Points',\


25. cTitle: 'Custom Page Size'});" 
+"if (nWidth == null) nWidth = 612;"  
+"var nHeight = app.response({ cQuestion:'Enter 
Height in Points',\


26. cTitle: 'Custom Page Size'});" 
+"if (nHeight == null) nHeight = 
792;"+"trustedNewDoc(nWidth, nHeight) "});


53


The  newPage.js file is contained in this 
portfolio.
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with data


Data can be collected from 
forms completed by Adobe 
Reader users, but distributing 
forms and aggregating data 
requires Acrobat. 


name


Address


City State 


eMail Address


Phone


Item Price Qty Amount


Ted Padova


555 Techo Way


Davao


ted@west.net


888.555.1212


Golf balls 39.95 $79.952


1


1


12.95 $12.95


29.95 $29.95


$122.80Total


Glove


Hat


PI


SUBMIT FORM
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Merging data into spreadsheets
You can easily aggregate data into spreadsheets from 
Acrobat. If you have forms that were not distributed 
and designed for retrieving via email or Acrobat.com, 
you can export the form data to a .csv file that can be 
opened in Microsoft Excel.


Here's how to do it.


	Choose Forms | Manage Form Data | Merge Data Files into 
Spreadsheet.


	Click Add Files in the Export 
Data From Multiple Forms 
wizard.


	Click Export.


	Click View File and the file 
opens in Microsoft Excel.


Distributing Forms
You can distribute forms in either Form Edit mode or Viewer 
mode and Acrobat 9 offers new distribution options. 


Do the following to distribute a form.


	Choose Forms | Distribute Form in either Form Edit 
mode or Viewer mode or click the Distribute Form but-
ton in Form Edit mode.


	Choose a collection method in the Distribute Form wiz-
ard. Your choices include:


	Distribute and collect forms on Acrobat.com.


	Distribute and collect forms via email.


	Distribute and collect forms on a web server.


	Click Next and you walk through steps to distribute the 
form.
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You can only export data into 
spreadsheets from Viewer mode. 
Aggregating data requires that 
all forms have identical field 
names. 
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Collecting Data Via Email
You can distribute forms for email collection. 
When form fillers send a form back to you 
it comes as an email attachment. When you 
double click the attachment, your form is 
automatically added to a PDF Portfolio.


	When you distribute a form, choose the 
option: Manually collect responses in 
my email box in the Distribute Form wizard.


	Click Next in the Distribute Form wizard and make a 
choice for: email now via Acrobat or save the file and 
email it later.


	Click Next in the Distribute Form wizard and choose a 
location for a data file to be saved on your hard drive.


	Click Next.


	Click Finished. The Form Tracker opens and your form is 
reported to have been successfully distributed. When re-
cipients email completed forms back to you, the dataset 
file is used to aggregate the forms in a PDF Portfolio.


Collecting Data Via Acrobat.com
Acrobat 9 introduces a new support service called Acrobat.
com. Using Acrobat.com you can share files, distribute 
forms, track reviews and forms, and hold web conference 
sessions.


Acrobat.com makes the process of distributing forms and 
collecting data a much easier task for managing forms than 
earlier versions of Acrobat.


To distribute a form on Acrobat.com, do the following:


	In the Distribute Form wizard choose: Automatically 
download & organize responses with Acrobat.com.


	Click Next.


	Log on to  
Acrobat.com.


	If you don't have 
an Adobe ID click 
Create Adobe ID. 
If you do have an 
ID, click Sign In.


	Your default 
web browser is 
launched and 
takes you to  
Acrobat. com. In 
the Acrobat.com 
interface you have 
options for track-
ing forms and 
managing form 
data.
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When prompted to save you 
dataset file, click the Browse 
button and locate a folder on 
your hard drive where you want 
the file saved. Be certain not 
move the file until you have col-
lected data from all recipients.
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Tracking Forms
The Tracker in Acrobat is used to track reviews and distributed 
forms. After distributing a form you use the Tracker to manage 
your distributed documents.


To open the Tracker, do the following: 


	Choose Forms | Track Forms in either Form Edit mode or 
Viewer mode.


	The Tracker provides several options that include:


	View Responses. Opens a PDF Portfolio where respons-
es can be viewed.


	View Responses. Opens a PDF Portfolio where respons-
es can be viewed and the data sorted and analyzed.


	Email All Recipients. Click Email all Recipients to send a 
message to all those invited to fill out the form.


	Email Recipients who Haven't Responded. Click and you 
can remind those who haven't responded to get on the 
stick and complete the form.
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Tools
Hardware and software tools used to create all documents within 
this portfolio are noted below.


Hardware:


	MacPro Dual Core 3GHz, 4G Ram, three 500G HDs.


	Apple Cinema HD 30" + Apple Cinema HD 23".


	HP Pavilion, Intel Dual Core 2.8Ghz, 2G Ram, 2 500G HDs.


	Two Sony 17" LCD Monitors.


Software used:


	MacOS X Leopard


	Windows Vista SP1


	Adobe Acrobat 9 Professional Extended.


	Adobe InDesign CS3.


	Adobe Photoshop CS3.


	Adobe Illustrator CS3.


	Adobe Flash CS3.


Fonts used:


	Adobe Avenir 35 Light.


	Adobe Avenir 65 Medium.


	Bradley Hand ITC TrueType.


	Courier New.


	Wingdings.


	Wingdings 3.


Design
All the PDFs contained in the Portfolio were laid out in Adobe 
InDesign on the Macintosh. After converting to PDF, the PDF 
Portfolios were assembled in Acrobat 9.0 on Windows where all 
the links, JavaScripts, and interactivity was added.


Adobe Flash files were designed on the Macintosh and added 
to the PDF Portfolio on Windows. Adobe Illustrator artwork and 
SWF files were likewise created on the Mac and imported on 
Windows.


The Mac was used in the design phase due to my having a total 
of 53 inches of screen real estate to keep open multiple CS3 
windows during the design process. 


InDesign:


The 101 eTips documents are a revision from an earlier version 
created for Acrobat 8 and hosted on www.acrobatusers.com. 
Therefore all word processing was a matter of revising text in 
the old documents. This permitted me to avoid Microsoft Word 
to type the raw text and have to import the text in the InDesign 
layout.


	Breaking page borders: The numbers breaking the page 
borders on the left edge of the document was handled in 
Adobe InDesign. To create a graphic or text that falls off 
the page when converted to PDF you must pay attention 
to a few details.


 The first item to understand is that an object or text must 
be placed on a Master page and the midpoint for the 
object/text frame must be inside the page area.


 If the center point for the object or image is outside the 
page area, when you convert to PDF and view the results 
in Acrobat you'll loose the object/text.
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	For objects such as Photoshop images and Illustrator 
artwork, if I needed to break a page border and the 
object's bounding box was too tight so I couldn't get 
the mid point inside the page edge, I imported a 1-pixel 
Photoshop transparent image, and grouped it together 
with the object to get the midpoint to fall within the page 
edge. 


	Master pages: Each object that breaks a 
page edge requires an individual master 
page. I set up the A master page for the 
top and bottom banners, the icons, and the 
background color. Each new master page 
was based on the A master page. There are 
a total of 50 master pages in the 101 Tips 
document. The portfolio has two files that 
were divided into two documents after the 
InDesign file was converted to PDF.


 


	Converting to buttons: When you add a graphic or text 
that breaks a page edge, you must place the item on a 
master page and convert it to button. Failure to convert 
the item to a button results in no object or text showing 
up in the PDF document.


 To convert an object or text frame to a button in  
InDesign, open a context menu and choose Interactive | 
Convert to Button. Don't worry about setting any actions 
to the button. It's used only for a graphic.


	Exporting to PDF: Notwithstanding color issues, that I 
address later, you export your layout from InDesign by 
choosing File | Export. In the Export dialog box, choose 
Adobe PDF for the Format and click OK. The Export 
Adobe PDF dialog box opens. 


 The last issue you need to be concerned about when 
using graphics/text that break page borders is to check 
Interactive Elements in the Include section of the Export 
to Adobe PDF dialog box. 
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	Images: Screen captures were taken on the Mac by press-
ing Command/Shift 4 + Spacebar and on Windows using 
the Shift + Print Src keys. For foreground dialog boxes 
and windows, I used the Alt + Print Src keys. On  
Windows, when a screen capture is made the screen shot 
is saved to the clipboard. Once on the Clipboard, use 
File | Create PDF | From Clipboard and save the file as 
TIFF for importing into InDesign.


 When importing into Photoshop, files were sized to  
physical dimensions without resampling. If you resample 
screen shots in Photoshop the screen captures text will 
appear distorted. Not resampling the images creates 
larger file sizes but the total file size for this PDF Portfolio 
was only 6.7MB. The combined files in the portfolio are 
coincidently much smaller than the individual PDF files.


	Color: Before exporting to PDF from InDesign, I created 
a custom preset for the Distiller settings. In InDesign 
I chose File | Adobe Presets | Define. I chose the High 
Quality Print setting to insure image quality and font em-
bedding and chose Acrobat 6 compatibility. I modified 
the Color settings and chose Convert All Colors to sRGB 
to use an RGB color palette with much richer colors.


 In InDesign I set up and RGB color palette so I could get 
the blue florescent look on the top and bottom banners.
The color would appear much different if the colors were 
converted to CMYK.


	Creating the PDFs: For the Tips booklet, I used the set-
tings described here for exporting the document and 
exported as a single PDF file. I wanted to keep the auto 
page numbers in order so I created one composite file. 


 After creating the composite file I extracted pages to 
create the two PDF documents contained in the PDF 
Portfolio. All other files were exported to PDF using the 
same settings.


Working in Acrobat
After the design files were converted to PDF, I copied the docu-
ments to a Windows machine and used Acrobat 9.0 Profession-
al Extended to assemble the PDF Portfolio and add the  
navigation links. I set all buttons used for images added in 
InDesign to Read Only in the General tab in the Properties 
window.


Assembling the PDF Portfolio:


	Adding files. I chose File | Create PDF Portfolio. I then 
clicked the Add Existing Folder button and added the 
folder containing my design files converted to PDFs to 
assemble the portfolio.


	Sorting Files. Files are organized in PDF Portfolios in an 
alpha order according to filename. I wanted the order to 
appear different than the default filename sort order.


 I clicked Specify File Details in the Edit PDF Portfolio pan-
el and added a new column I named Sort. I chose Num-
ber from the drop down menu adjacent to the new name 
and clicked the + (plus) button to add a new column. 


4







ted padova ted@west.net 



colophon


 I typed the numbers in the new Sort column for the order 
I wanted and then clicked the ascending (A


Z) button to 
sort my documents in ascending order.


	Choosing a layout. I clicked the Choose a Layout button 
in the Edit PDF Portfolio panel and clicked the Revolve 
option from the Basic Layouts choices.


	Add a Welcome. Next, I clicked Add a Welcome & Head-
er in the Edit PDF Portfolio panel and clicked the Flash 
Movie option for the Welcome page. In the left panel just 
click the Add a Flash file button and you can import an 
Adobe Flash SWF file.


Assembling the PDF Portfolio:


 After the portfolio was assembled, it was time to add the 
navigation links to make it easier for a viewer to follow 
the journey of browsing the portfolio. 


 The JavaScripts and button actions that are included in 
the Writing JavaScripts chapter were all created before 
the portfolio was assembled. There are sample codes 
and scripts to invoke actions that don't have anything to 
do with browsing the portfolio. However when I needed 
to set up a link to another file in the portfolio, these links 
need to be added after you create a PDF Portfolio.


	Linking to files in a PDF Portfolio. A few examples of 
JavaScript code require opening a companion file that 
shows a little more detail than can be added in the tips 
booklet. I have some hot links that take you to the other 
files without having to use the PDF Portfolio interface to 
navigate documents.


 To link to another file in a PDF Portfolio, double click a 
file in the Home view to open the document in the PDF 
Portfolio Preview mode. Choose Tools | Advanced  
Editing | Link Tool. Notice the only Advanced Editing tool 
available while in Preview mode in a PDF Portfolio is this 
tool.


 Create a link and define the appearance properties in the 
Link Properties dialog box. 


 Click Actions and choose Go to a page view from the  
Select Action drop down menu. Note that you cannot 
use Open a file for the action type.


 Click the Add button and the Create Go to View dialog 
box opens. You can navigate your PDF Portfolio while this 
dialog box is open, so don't close the dialog until you 
click the Set Link button.
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 Click the Home icon (far left side of the PDF Portfolio 
toolbar) and you return to the Home view. From here 
you can open any file in the portfolio. In my example I 
opened the housePlansForm.pdf document. Double click 
the file in the Home view and the target document opens 
in Preview mode. Click Set Link in the Create Go to View 
dialog box and the link is set. You are then returned to 
the page where the link was created.


	Returning to views. I wanted the reader to view a com-
panion file, then return back to the same tip they were 
reading when the link was clicked. Therefore I needed 
to add links in the companion files back to the page of 
origin when the reader clicked a link.


 In the companion documents, I used a button. I still 
needed to create the buttons after the PDF Portfolio was 
assembled, but the Button tool is not accessible while in 
Preview mode. You have to open a PDF in a new window 
when you want to add any form fields.


 Continuing with the same example, I chose the  
housePlansForm.pdf document in the Home view and 
double clicked to open it in Preview mode. I then clicked 
the Open button (far right side of the PDF Portfolio 
toolbar) and the file opened in a new window. When in 
this view, you have access to all of Acrobat's tools and 
commands.


 I clicked the Button tool from the Advanced Editing  
toolbar and added a button with a button face. In the  
Actions tab I chose Go to a page view again from the 
Select Action drop down menu. When I clicked the Add 
button the Create Go to View dialog box opened again.


 At this point I was in the new window view and not within 
the PDF Portfolio interface. The easiest way to get back 
to the portfolio was to chose Window | <portfolio file-
name>. Once back in the PDF Portfolio I could navigate 
to my document with the original link and click the Set 
Link button. When I returned to the file open in a new 
window I saved the document and closed the window. 
Doing so takes you back to the PDF Portfolio interface.


 As you browse the files in this portfolio you can open the 
link and button properties and examine the settings.


 This type of file linking is helpful for those who have a 
main document where you want viewers to browse a file 
in a linear read while offering support files to amplify 
topics descriptions and concepts. If left to the reader to 
branch out to view companion files, the reader can get 
frustrated trying to go back to the last page in the main 
document. Each time you return to the Home view, the 
file always opens on the first page and not the last page 
viewed in a document.
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	Navigating chapters. The page navigation buttons used 
for navigation within a document in the tips booklet were 
all created before the PDF Portfolio was assembled. A 
few links however, needed to be created after the PDF 
Portfolio was assembled. 


 The button on the last page of the first part of the 
booklet links to the first page in the second part of the 
booklet. Essentially this is a button that opens another 
file in the PDF Portfolio. The procedure for creating the 
button is the same as explained in the previous section 
where you use the Go to a page view action for a button. 
The first page in the second document has a link to move 
back to the last page in the first document.


 Creating navigation buttons like these can help you 
design eBooks that are broken up into separate chapters 
as individual files. As the reader clicks the arrow link but-
tons used in my example, pages scroll forward/backward 
thereby giving the reader the impression that it's one 
long document.


Ad Enabled PDFs
You may wonder why the booklet is divided into two files. 
Notice that the tips booklet includes Ads from Yahoo! You can 
create an account with Yahoo! to ad enable PDF files as a free 
service cooperatively offered by Adobe and Yahoo!


To get started with enabling PDFs with Yahoo! ads, log on to 
Adobe Labs at: http://labs.adobe.com/technologies/adsforpdf/ 
for more information on how to get started.


The one limitation that you have with using the service is the 
file sizes can be no more than 10MB. Since my single compos-
ite file was over 10MB, I needed to split the PDF into two parts.


After my portfolio was assembled and all the link actions 
added, it was time to submit the files for enabling with Yahoo! 
ads. You must add all links before submitting files for enabling 
with ads. Once the file is enabled, it's like a secure file prevent-
ing you from all editing features. 
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	Renaming files. You submit files for enabling and within 
10 minutes your files are returned via an email attach-
ment. When the files are returned, the filenames are 
appended with -registered. Since you set up your original 
links to files without the appended text at the end of the 
filename, you need to rename the files to return to the 
original names before you submitted them for ad  
enabling.


	Replacing files. You don't have a Replace File command 
in the PDF Portfolio interface. You need to simply delete 
the old files and add the ad enabled files to your PDF 
portfolio.


 To delete a file from a PDF Portfolio, view the files in the 
Home view and open a context menu on a file you want 
to delete. From the menu choices click Delete.


 To add the ad enabled files, click the Add Files button 
in the Home view. After you add the files, you'll need to 
revisit the Details view and add the sort numbers to sort 
the files in the order you want your readers to see them.


 As a last step, choose File | Save Portfolio As and rewrite 
the entire portfolio file to optimize it. 


 And that's basically how I created the portfolio you're 
viewing now.


Commercial


 To learn more about PDF Portfolios,  
using Adobe Acrobat 9.0, Adobe LiveCycle 
Designer, and discovering all the wonder-
ful tools and features you have for creating 
PDF forms, become a regular visitor to 
Acrobat Users (www.acrobatusers.com)
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